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Introduction 

Sunergi Honors allows you to generate the financial data file 
needed for annual submission to the North Dakota State 
Department. You’ll prepare for this report by crosswalking the 
accounts required for the North Dakota School District Financial 
Reports (NDSFARM) to the appropriate accounts in your Microsoft 
Dynamics GP chart of accounts.  

What’s in this manual 

This information is intended to give you an overview of the 
NDSFARM features of Honors, and how they work with Microsoft 
Dynamics® GP. This documentation assumes that you are familiar 
with the basic features of Microsoft Dynamics GP General Ledger. 

This documentation includes the following topics: 

 NDSFARM overview on page 2 

 Importing state account numbers on page 2 

 Assigning Microsoft Dynamics GP accounts to NDSFARM 
accounts on page 3 

 Validating accounts on page 5 

 Generating the annual submission file on page 6 

 Appendix A: Window Reference on page 8 

 Appendix B: Sample Reports on page 14 

Documentation conventions 

This documentation uses the following formatting and conventions 
to indicate topics, navigation, and other information: 

Convention Description 

Selecting voucher transactions Italic text indicates the name of a topic. 

NDSFARM Routines Bold text indicates the name of an interface 

element—a window, field, button, menu, or menu 

item. 

File > Print The > symbol indicates a sequence of actions, 

such as selecting items from a menu or toolbar, 

or clicking a button in a window. This example 

directs you to go to the File menu and click Print. 

TAB, ENTER Small capital letters indicates a key or key 

combination. 
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Contacting support 

If you need technical support, you can contact the Sunergi support 
department by email or telephone.  

 For email support, send your request to 
support@sunergi.com.  

 For telephone support, call 651-259-1408.  

Note 

We recommend contacting our support team by email. This 
method automatically generates a service ticket, ensuring a 
prompt response. 

NDSFARM overview 

The North Dakota Department of Public Instruction requires that 
local education agencies submit an annual financial report, which is 
used to compile statewide financial information about revenues and 
expenditures for K-12 education. The accounts in this report must 
be assigned to the following state-defined categories: Fund Balance, 
Revenue, and Expenditure. 

Note 

The NDSFARM features of Honors also allow you to assign 
accounts to two additional types—Asset and Liability. However, 
these are not included in the annual financial report. 

In addition, the report requires that the accounts use a state-
defined account number, consisting of the following segments: 
Fund Code, Program Code, Function Code, and Object Code. These 
are required for state reporting purposes. 

The NDSFARM features of Sunergi Honors allows you to 
associate—or crosswalk—the accounts in your Microsoft Dynamics 
GP chart of accounts with the corresponding state-defined account 
numbers. This way, you can maintain your chart of accounts in a 
structure that meets your district’s needs, and easily create the 
annual financial report in the format required by the Department of 
Public Instruction. 

Importing state account numbers 

The first step in setting up the Sunergi Honors system to create the 
annual NDSFARM submission file is to import the list of state-
defined account numbers that are used for generating the 
submission file. You’ll use the NDSFARM Routines window to 
import these codes. 

mailto:support@sunergi.com
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You should already have the code file—in Microsoft Office Excel® 
format—in a folder or network location available to the computer 
you complete this procedure on. This file is available from the 
Sunergi. 

Note 

If you have previously imported state account numbers, repeating 
this procedure will replace the existing account numbers with the 
new account numbers. 

1. Open the NDSFARM Routines window.  
(Microsoft Dynamics GP > Tools > Routines > 
Financial > NDSFARM) 

 

2. Select the Import Code File option. 

3. Click the File button on the Path field to open the File 
Location window. Browse to the location of the code file. 
Select the file and click Open. 

4. In the NDSFARM Routines window, click Process.  

5. A message will appear, stating that importing NDSFARM 
account numbers will delete existing accounts. Click 
Continue to import the state account numbers. A progress 
bar will appear on the bottom of the NDSFARM Routines 
window, showing the progress of the import process. 

6. When the import process is complete, close the window. 

Assigning Microsoft Dynamics GP accounts to NDSFARM 
accounts 

After you have imported the NDSFARM account numbers, you 
must crosswalk—or associate—these account numbers with the 
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appropriate accounts in your chart of accounts. This ensures that, 
when you generate your annual submission file, the transactions in 
your General Ledger will be reported using the account structure 
required by the State of North Dakota. 

Note 

You can crosswalk a single NDSFARM account code to multiple 
accounts in your Microsoft Dynamics GP chart of accounts. 

If you have GL accounts that you don’t want to associate with an 
NDSFARM account number, and that should not be included in the 
annual submission file, you can mark these accounts as exempt. 

1. Open the Account Maintenance window. 
(Cards > Financial > Account) 

 

2. Enter or select the first account that you want to crosswalk 
with a state account code. 

3. In the Account Type field, select the appropriate account 
type. You can select one of the following: 

 Fund Balance 

 Revenue 
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 Expenditure 

 Asset 

 Liability 

Note 

If this account has previously been crosswalked with a state 
account code, selecting a new account type will clear the 
information from the NDSFARM Account Number and 
Description fields. 

4. If selected Fund Balance, Revenue, or Expenditure as the 
account type and you want to crosswalk this account with an 
NDSFARM account number, in the NDSFARM Account 
Number field, enter or select the state account code you 
want to crosswalk this account to. (Asset and Liability 
accounts are not used for state reporting; therefore you don’t 
need to crosswalk an NDSFARM account number to them.) 

However, if you selected Fund Balance, Revenue, or 
Expenditure as the account type, but you want to exclude the 
account from state reporting and validation, do not enter a 
state account code. Instead, mark the Exempt option. 

5. Click Save to save your changes. 

Validating accounts 

Use the NDSFARM Routines window to validate that your accounts 
have been properly set up for generating the annual submission file. 
This process checks for the following conditions: 

 Any Fund Balance, Revenue or Expense GP account that has 
not been crosswalked to an NDSFARM account. 

 Any Fund Balance, Revenue or Expense GP account that has 
been crosswalked to an NDSFARM account, but that is no 
longer valid according to the file provided by the state. 

 Any NDSFARM account that has an invalid account type. 

If the system finds any of these conditions, the Account Validation 
Error Report will be generated, showing the invalid information. 

If the process does not find any errors, it will check for the 
following: 

 Any accounts that have been marked as exempt; if any are 
found, the NDSFARM Exempt Report will be generated. 

 Any Fund Balance or Revenue accounts that have a debit 
balance, or any Expenditure account that has a credit 
balance; if any are found, the NDSFARM Exception Report 
will be generated. 
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1. Open the NDSFARM Routines window.  
(Microsoft Dynamics GP > Tools > Routines > 
Financial > NDSFARM) 

 

2. Select the Validate Accounts option. 

3. Click Process. A progress bar will appear, displaying the 
progress of the validation process. 

4. The system will check your accounts, and if necessary, 
generate the appropriate reports. 

Generating the annual submission file 

Use the NDSFARM Routines window to generate the report file for 
submission to the North Dakota Department of Public Instruction. 

1. Open the NDSFARM Routines window.  
(Microsoft Dynamics GP > Tools > Routines > 
Financial > NDSFARM) 
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2. Select the Generate Submission File option, then select 
the fiscal year you’re creating the submission file for. 

3. Click the File button on the Path field to open the File 
Location window. Browse to the location where you want to 
save the submission file, and enter the name of the 
submission file in the File Name field. Then click Open. 

4. In the NDSFARM Routines window, click Process. The 
system will validate your accounts and, if it does not 
encounter any errors, generate the submission file in the 
location you specified. A progress bar will display the 
progress of the validation process. 

Note 

If the system encounters errors during validation, the 
Account Validation Error Report will be generated, and the 
submission file will not be created. You must correct the 
errors listed in the report before you can create the 
submission file. 

5. After the annual report submission file is created, submit it 
to the North Dakota Department of Public Instruction, 
following their submission instructions. 
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Appendix A: Window Reference 

This part of the documentation includes descriptions of the 
following NDSFARM windows: 

 NDSFARM Routines 

 Account Maintenance 

 NDSFARM Account Lookup 

NDSFARM Routines 

Microsoft Dynamics GP > Tools > Routines > Financial > 
NDSFARM 

Use NDSFARM Routines window to perform the following 
procedures: 

 Import the list of state-defined account numbers to be cross-
walked to your chart of accounts. 

 Validate your chart of accounts. 

 Generate the annual submission file. 

Fields 

Fiscal Year 

If you are generating the annual submission file, select the fiscal 
year you want to generate the file for. 

Generate Submission File 

Mark this option if you want to generate the annual submission file. 
For more information, see Generating the annual submission file 
on page 6. 

Import Code File 

Mark this option if you want to import the file containing the state-
defined account numbers. For more information, see Importing 
state  on page 2. 

Path 

If you are importing the code file, click the File button to navigate 
to the location of the code file; then select the file and click OK. 

If you are generating the annual submission file, click the File 
button to navigate to the location where you want to save the file, 
and then click OK. 

Validate Accounts 

Mark this option if you want to check your chart of accounts for any 
errors in cross-walking the state-defined account numbers to your 
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chart of accounts. For more information, see Validating accounts 
on page 5. 

Buttons 

Cancel 

Closes the window without starting any process. 

Process 

Launches the type of process you selected: importing the state code 
file, validating your chart of accounts, or generating the annual 
submission file. 

Account Maintenance 

Microsoft Dynamics GP > Cards > Financial > Account 

Use the Account Maintenance window to set up, modify, inactivate 
or delete posting accounts. You can't delete accounts that have 
activity or history associated with them. 

In addition, you’ll use this window to crosswalk—or associate—
accounts in your chart of accounts to the appropriate NDSFARM 
state account numbers.  

Fields 

Account 

Enter a new or existing account. 

Account expansion button 

Opens the Account Entry window, where you can enter an 
account using an alias. 

Organization button 

Opens the Organizational Structure Assignment 
window, where you can assign the selected account to 
positions in the organizational structure. You can assign an 
account to more than one position in the organizational 
structure. See the System Setup instructions in the Microsoft 
Dynamics GP documentation for more information about 
organizational structure assignments. 

Account Type 

Select the account type for this account. You can select one of the 
following: 

 Asset 

 Expenditure 

 Fund Balance 
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 Liability 

 Revenue 

Alias 

Enter an account alias for the account you're setting up. You can 
enter an account alias instead of an entire account to speed data 
entry. 

Allow Account Entry 

Mark this option if you want to allow users to manually enter this 
account in transaction or distribution entry windows. If you 
unmark this option, you will not be able to manually enter this 
account in a transaction or distribution entry window. 

Category 

Enter or select an account category, which is used to group accounts 
on financial statements. 

Closing Account 

Enter or select the fund balance account that you want to use to 
close this account’s net income or loss amounts to during the Year-
End Close process. 

Description 

Enter a description for the account. This description will appear in 
windows where accounts appear, and also can be displayed on 
financial reports. 

Exempt 

Mark this option if you want to mark a Fund Balance, Revenue, or 
Expenditure account as being exempt from state reporting and 
validation. 

Inactive 

Mark this option to inactivate this account. An unmarked checkbox 
indicates that the account is active. You might want to inactivate 
accounts if they are used for a branch of your business that closed 
during the year. At the end of the year, inactive accounts will be 
included on closing reports. Inactive accounts that don’t have a 
balance, that aren’t included on any saved, open, or historical 
transactions, and that are not distribution accounts for allocation 
accounts will be deleted. 

Include in Lookup 

Select the product series where you expect to use this account. The 
account will appear in all lookup windows for the selected series. 
Select the series you're using now, and those you plan to use in the 
future. 
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Level of Posting from Series 

Specifies how much detail to post to General Ledger from each 
series—Sales, Inventory Control, Purchasing, and Payroll—if the 
transaction origin is set up to use account settings. Select Detail to 
post detailed information about each line item for a group of 
transactions. Select Summary to post a summarized total for a 
group of transactions for this account. 

NDSFARM Account Number 

If this account is a Fund Balance, Revenue, or Expenditure account, 
enter or select the state account code that this account should be 
crosswalked to. 

NDSFARM Description 

Displays the description of the state account that you selected to 
crosswalk this account to. 

Posting Type 

Mark whether the account should be closed to a closing account at 
the end of the year, or have a balance brought forward to the next 
year. 

Balance Sheet 

Mark this option to bring forward the account's balance at 
the end of the year. Use this option if you're setting up an 
asset, liability, or owners' equity account. 

Profit And Loss 

Mark this option to close the account's balance to a closing 
account at the end of the year. Use this option if you're 
setting up a revenue or expense account. 

Typical Balance 

Mark whether this account has a debit balance or a credit balance. 
When you enter transactions for this account, the insertion point 
moves automatically to the column you indicate here. 

The option you mark also determines how the account is displayed 
on financial statements; if the account typically has a debit balance, 
but currently has a credit balance, the account balance would be 
shown in parenthesis. 

User-Defined 1 – 4 

Enter additional information about the account you're setting up. 
The information also will appear on the Posting Accounts List and 
the Accounts List beneath the headings that correspond to the field 
labels displayed in this window. The user-defined field labels were 
entered in the General Ledger Setup window. 

javascript:SecWin2.Click()
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Buttons 

Analysis 

Opens the Account Analysis Defaults window, where you can 
assign analysis groups to accounts. 

Budget 

Opens the Single-Account Budget Maintenance window, 
which can be used to calculate or modify budget amounts for 
individual accounts. 

Clear 

Clears the entries you've made and allows you to continue working 
in this window. 

Currency 

Opens the Select Account Currencies window, if you’re using 
Multicurrency Management. Use this window to select the 
currencies that can be used with multicurrency transactions using 
each account, select accounts that will be revalued when the 
revaluation procedure is performed, and specify a financial 
statement translation method and an optional historical exchange 
rate for each multicurrency posting account. 

If you're not using Multicurrency Management, this button isn’t 
available. 

Delete 

Deletes the account if it has a zero balance, no year-to-date 
transactions, is not part of an allocation account, and has no history 
records. You can't delete an account if it’s assigned to a transaction 
in a batch in the Transaction Entry window, Clearing Entry 
window, or Quick Journal Entry window, or if the account has 
unposted Multidimensional Analysis records. 

History 

Opens the Account History window, which displays historical-
year summary information for the selected account. You must mark 
Maintain Account History in the General Ledger Setup 
window for this button to be active. 

Save 

Saves the changes you've made in this window. 

Summary 

Opens the Account Summary window, which displays summary 
information for the selected account for an open year. 
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NDSFARM Account Lookup 

Microsoft Dynamics GP > Cards > Financial > Account > 
Click the Lookup button on the NDSFARM Account 
Number field 

Use the NDSFARM Account Lookup window to select the 
NDSFARM account that you want to crosswalk to the account 
selected in the Account Maintenance window. 

Fields 

Account Number 

This column displays all of the state-defined accounts of the type 
displayed in the Find by Account Type field. Click the account 
you want to crosswalk to the GL account displayed in the Account 
Maintenance window, and click Select. 

Description 

This column displays descriptions for each of the state-defined 
accounts displayed in the list. 

Find by Account Type 

Displays the account type of the GL account displayed in the 
Account Maintenance window. 

Buttons 

Cancel 

Closes the window without selecting a state-defined account. 

Select 

Updates the NDSFARM Account Number and Description 
fields in the Account Maintenance window with the state-
defined account that you selected. 
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Appendix B: Sample Reports 

Posting Accounts List 

The Posting Accounts List displays information about the posting 
accounts in your chart of accounts. 

This list includes information about the NDSFARM accounts that 
an account is crosswalked to. 

 

Options: 

 Sort by: 

 Segment ID  

 Account Description 

 Category 

 Include Inactive Accounts  

 Ranges: 

 Segment ID 

 Account Descriptions 

 Category 

Columns: 

 Account 

 Description 

 Alias 

 Category 

 Active 

 Account Type 

 Posting Type 
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 Typical Balance 

 User-Defined 1 – 4 

 Account Type* 

 NDSFARM Account  

 NDSFARM Account Description 

*The second Account Type column displays the NDSFARM account 
type assigned to this account. 

Account Validation Error Report 

The Account Validation Error Report displays the Microsoft 
Dynamics GP accounts in your chart of accounts that meet the 
following criteria: 

 Any Fund Balance, Revenue or Expense GP account that has 
not been crosswalked to an NDSFARM account. 

 Any Fund Balance, Revenue or Expense GP account that has 
been crosswalked to an NDSFARM account, but that is no 
longer valid according to the file provided by the state. 

 Any NDSFARM account that has an invalid account type. 

 

Columns: 

 Dynamics GP Account Number 

 Account Type 

 NDSFARM Account 

 Error Message 

NDSFARM Exception Report 

The NDSFARM Exception Report displays the Microsoft Dynamics 
GP accounts in your chart of accounts that meet the following 
criteria: 
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 Any Fund Balance or Revenue accounts that have a debit 
balance. 

 Any Expenditure account that has a credit balance. 

 

Columns: 

 Account Type 

 NDSFARM Account 

 Overall Amount 

 Message 

 Dynamics GP Account 

NDSFARM Exempt Report 

The NDSFARM Exempt Report displays the Microsoft Dynamics 
GP accounts in your chart of accounts that have been marked as 
exempt in the Account Maintenance window. 
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Columns: 

 Account Type 

 Account Number 

NDSFARM Summary Report 

The NDSFARM Summary Report displays a summary of the 
information in your annual submission file. 

 

Columns: 

 NDSFARM Account 

 Dynamics GP Account 

 Description 

 Beginning Balance 

 YTD Debit 

 YTD Credit 

 Ending Balance 

NDSFARM Submission File 

This text file contains the financial data you are required to submit 
to the North Dakota Department of Public Instruction, formatted in 
the state’s layout standards. 
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Columns: 

 District Number 

 School Year 

 Account Type 

 Fund Code 

 Program Code 

 Function Code 

 Object Code 

 Amount 

 


